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Screen Layout 
 

 

Main Graphics Area – 
displaying geometry 
and toolpath’s Tooling definitions 

Program operations 
such as Select Tool, 
Face off, Profile Turn 
etc

Status Panel

NC code area – only 
seen after Post 
processing 

Depending on your screen resolution the above layout may be different on 
you PC, don’t’ forget all toolbars are dockable in your preferred locations. 

 

All of the individual panes of the above display screen can be re-
sized by dragging the bordering bars. Toolbars can be switched 

on and off by means of the commands under the View - 
Toolbars sub-menu 

 

Main Menu The main menu consists of a series of 9 menus, which control all 
aspects of Dolphin CAM.  

Toolbars 
The toolbars contain buttons, which offer quick access to the 
main functions. All of these operations are also available via the 
menus. See Toolbars 

Tooling Definitions area 
This area is used to display all the tools that you have defined 
within the program, either by means of the Tooling Menu or by 
the Tool Definition buttons within the Operations Toolbar.  
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Program Operations 
area 

This area is used to display all the machining operations that you 
have defined by means of the Machining Menu or the by the 
buttons in the Operations Toolbar.  

Graphic Display area 
This area is used to display the geometry that you have created 
or imported. The cutter paths and machining sequences that you 
define in Dolphin CAM are also displayed here.  

Edit Area This area is used to display the NC code generated when the 
program is executed via one of the post processors.  

Status Panel The Status panel contains a constantly updated display of 
various parameters for the current program.  

Status Bar The Status bar shows information about the button or menu field, 
which lies under the cursor.  

 

Program Operations 
 

 
As each operation in the machining sequence is defined it is added to the bottom of the list in 
the Program Operations Pane. You can re-set the size of this pane to the full window size by 
means of the Operations command in the Window Menu. The Tile command in the same 
menu will set all the panes within the display window back to the default configuration. 

Activate/De-activate operation 
Each operation is preceded by a box, which contains either a tick or a cross. When the 
operation is first defined the box is ticked, showing that the operation is activated. If you wish 
to de-activate the operation, simply click on the box with the left hand mouse button. Only 
those operations that are activated will be carried out when the program is executed for a 
simulation or to produce NC code via the post processor. 

Edit an operation 
To edit an existing operation, double click on the entry with the left hand mouse button. The 
Dialog that defines the operation will be displayed showing all the values and parameters that 
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you originally set. Make any necessary alterations and then click on OK. Note that the 
alterations will NOT be carried out until the program has been executed after the alteration.  

Errors within a sequence 
If the operation icon is followed by a question mark, it means that Partmaster has found a 
problem within the operation during execution. Use the Edit procedure as shown above, to 
correct the error. 

Re-order operation sequence 
To re-order the operations simply click on the text part of the entry and, holding down the 
mouse button, drag the operation to the required position within the sequence. Upon release 
of the mouse button the operation will be placed in the new position within the list and the 
entries will be automatically re-numbered. 

Delete operation sequence 
To delete an operation from the sequence simply click on the text part of the entry and hit the 
delete key on the keyboard or select Delete from the Edit Menu. 

Insert operation into sequence 
A new operation is always added to the bottom of the sequence. Define the operation as 
required and then use Re-Order as described above to move the operation to the required 
position. 

Block Copy, Cut & Paste operations can also be performed on multiple entries in the 
program operations list. Any selection of items in the list can be made by holding down the 
Control key whilst clicking with the left hand mouse key on the desired items. A sequential 
group of items may be selected by clicking on the first & last items whilst holding down the 
Shift key. By clicking with the right hand mouse button a new menu is displayed with the 
following options 

 

 

Program Simulation 
 

 
This group of buttons controls the simulation of the program that you have defined. 

 This button sets the simulation to single step mode. Every time 
you press the Execute button, only the next operation in the 
sequence will be carried out. Note that a Tool Definition or a Tool 
Select command is counted as an operation. This button is the 
same as the menu field Execute - Single Step 

 Starts the execution of the program simulation The button on

 7



the Status Panel is the same as this. This button is the same as 
the menu field Execute - Run Program 

 Stops the execution of the program simulation. Note that this 
button is only available if a simulation is actually running. The 

button on the Status Panel is the same as this. The menu 
field Execute - Stop Program has the same effect as these 
buttons 

 Pressing this button when a program simulation is running will 
have the effect of speeding up the simulation. This button is the 
same as the menu field Execute - Faster. The Simulation 
Speed control on the Status Panel has the same effect as this 
button. 

 Pressing this button when a program simulation is running will 
have the effect of slowing the simulation down. This button is the 
same as the menu field Execute - Slower. The Simulation 
Speed control on the Status Panel has the same effect as this 
button. 

See also: Status Panel  & Execute Menu 

 

Status Panel 
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Tooling Definitions Panel 
 

 
As each tool is defined it is added to the bottom of the list in the Tooling Definitions Pane. 
You can re-set the size of this pane to the full window size by means of the Tooling 
command in the Window Menu. The Tile command in the same menu will set all the panes 
within the display window back to the default configuration. 

Edit a Tool Definition 
To edit an existing definition, double click on the entry with the left hand mouse button. The 
Dialog that defines the tool will be displayed showing all the values and parameters that you 
originally set. Make any necessary alterations and then click on OK. Note that the alterations 
will NOT be carried out until the program has been executed after the alteration.  

Delete Tool Definition 
To delete an operation from the sequence simply click on the text part of the entry and hit the 
delete key on the keyboard or select Delete from the Edit Menu. 

See Also: Define Turning Tool & Define Drilling Tool 

 

NC Code Area 

 

 
This area of the screen displays the NC code which is generated by means of the Execute - 
Post Process command. See Post Process. The font that is used for the text display may be 
changed by means of the View - Editor Font command. See View - Editor Font 

The display of this area can be switched on and off by means of the View - NC Program 
command in the View menu    
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The code displayed can be edited by means of a full screen editor, which is active when the 
screen cursor is clicked within the area.  

USE WITH CARE 
If the NC code is edited in this manner; please remember that it no longer matches the 

defined program and the post-processor that was used. If the program is re-run in the future 
the NC code generated will NOT be the same as the edited version.  

 

  

Top Toolbar 
 

 

This Toolbar contains all the major global operations necessary Open, Save and print 
programs and also options for how the screen will presented and how to draw the tools, and 
execute (run) a program 

Operations Toolbar - Turning 
 

 
This Toolbar contains all the major operations necessary to define an NC program. The 
buttons are laid out in a logical progression: 

i.e. at the left hand end (top) is the Setup button. This operation must be carried out before 
any of the other commands are made available. The second button enables you to define a 
tool, the third button enables you to select a tool. No machining operations will become 
available to you until you have performed these two operations in the correct order - you 
cannot select a tool if you haven't defined one. 

The button at the extreme right (bottom) calls the post processor which will convert and output 
the program in the appropriate NC code for the chosen machine.  

 

 

Miscellaneous Toolbar - Turning 
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This Toolbar contains many secondary and optional operations necessary to define an NC 
program. . 

NOTE: The actual output of many of the miscellaneous operations are completely 
dependent upon the post processor settings!  

 

Turning Menus 
 

The main turning menu consists of a series of 9 menus, which control all aspects of Dolphin 
CAM turning 

 

FILE This menu contains commands concerned with loading 
and saving programs, printing and page setup 

EDIT
This menu contains commands to cut, copy and paste 
information and also enables you to undo unwanted 
operations or mistakes and to edit the postprocessor 

SETUP
This menu enables you to set up the main machine 
parameters including the tool change position, safe 
position, tool fixture positions etc. 

TOOLING This menu contains all the option necessary to define and 
select tools for the machining sequences 

MACHINING
This menu contains all the options necessary to define 
machining sequences - area clearance cycles for turning 
and facing, boring, profile turning, drilling cycles etc. 

MACROS This menu contains commands to control the generation 
and execution of Visual Basic Scripts (Macros) 

VIEW

The view menu has two main functions: it allows you to 
alter which screen elements are displayed (toolbars etc.) 
and how the cursor appears, secondly it controls the 
display of geometry and toolpath simulation for the 
program that you have defined  

EXECUTE This menu contains the options available for simulating the 
program that you have defined. 

WINDOW This menu enables you to select which of the various 
frames are displayed in the program window. 

HELP Offers access to this help file and information about 
Dolphin CAM (Version No. etc:). 

 

 11



 

Graphic Display - Turning 
 

This part of the screen is used to display the geometry which defines the workpiece, together 
with the raw material blank if defined. It is also used to simulate the cutter path when the 
program is executed.  

The display options can be accessed via the Options field on the View menu or via the 
button on the main toolbar. 

Toolpath Display 
The toolpath and machining that you define can be displayed in three different ways as 
follows: 

The toolpath is shown as the centre 
line only of the cutter tip radius. Cutting 
moves at feedrate are shown as blue 
lines, retract and approach moves at 
rapid speed are shown as dotted red 
lines.  

The button on the main toolbar is a 
shortcut for this option. 

 

A full simulation of the cutter path with 
an animated cutter is shown. Note that 
full tool geometry can only be shown if 
the tool geometry is defined within a 
tool database. Cutting moves at 
feedrate are shown as blue lines, 
retract and approach moves at rapid 
speed are shown as dotted red lines.  

The button on the main toolbar is a 
shortcut for this option. 
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The toolpath is shown as full 
simulation of the cutter. The blank 
material is shown as a filled body 
which is removed as the cutter path is 
simulated. This option is the nearest to 
a full visual re-creation of the turning 
process.  

The button on the main toolbar is a 
shortcut for this option.  

  

 

Geometry Display 
In the turning module the view that can be displayed is limited to the plan view shown by the 

icon on the top toolbar. 

Sub-options are available as follows:  

1 The geometry can be shown at the work surface only or with depth (if 
defined): meaningless within the Turning module, but one of the two 
must be chosen 

2 The names of geometric entities can be displayed 
3 The span numbers of elements within geometric entities can be 

displayed 
4 The direction of spans within geometric entities can be displayed 
5 Enhance Profiles: This option adds view lines across the profiles which 

produce a correct side view of the workpiece. 

All of these options can be accessed via the Options field on the View menu or via the 
button on the main toolbar. 
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Setup - Billet - Turning 
 

This command enables you to define a billet (blank) for turning. The command is not available 
if the Machine Type is set to a milling machine. 

   

A  non-cylindrical billet such as a casting can be defined by means of a profile which you can 
choose from within the list of defined geometric elements in the lower part of the dialog. A 
billet which is defined by a profile can be accessed in the Face/Turn dialog and used as an 
outer limit to the machining, thus reducing unwanted air cutting.    

 

To view the Billet the Tool drawing option must be set to this option. 

The toolpath is shown as full 
simulation of the cutter. The blank 
material is shown as a filled body 
which is removed as the cutter path is 
simulated. This option is the nearest to 
a full visual re-creation of the turning 
process.  

The button on the main toolbar is a 
shortcut for this option.  

  

 

 

Having set the tool drawing option you must re-draw   the screen to see the Billet. 
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CREATING PROGRAMS 

 
Creating programs within PartMaster CAM is a sequential process, below are 
listed the steps required. 
 

1) Define the tool you wish to use and set the tool type, tip radius and 
angles, maximum cutting depth etc. 

 
 

2) Select the tool for use - in effect invoke a tool change sequence, here 
we set the spindle speed, federate etc. 

 
 

3) Choose the machining option required, this could be for instance facing 
off the bar, performing a roughing cut or cutting a groove. 

 
 

4) View the tool graphics on screen and check that the operations you 
have defined are correct. 

 
 

5) Invoke the post processor to convert the graphics you see on screen 
into machine tool language, most commonly Gcodes. 

 
 

6) Send the program to the machine tool controller via the RS232 port, or 
perhaps your machine might have a floppy disk fitted. 

 
The actual program to cut even the simplest of components might have many 
operations, for instance:- 
 

1) Define a facing off tool, tool number 1 
2) Select tool 1 and set the speeds/feeds 
3) Use the Face/Turn macro to perform the operation 
4) Define a roughing tool, tool number 2 
5) Select tool 2 and set the speeds/feeds 
6) Use the Face/Turn macro to rough out from the stock to the profile 

leaving a finishing allowance. 
7) Define a finishing tool, tool number 3 
8) Select tool 3 and set the speeds/feeds 
9) Use the Profile turning operation to perform the finishing cut. 
10) Define a parting off blade, tool number 4 
11) Select tool4 and set the speed/feeds. 
12) Invoke the part catcher to catch the part before parting off. 
13) Part off the component. 

 
For some examples use File > Open and navigate to the Examples Folder. 
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EXECUTING PROGRAMS 
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Execute - Run Program 
 

This command starts the execution of the program simulation. The button on the Status 
Panel is a short cut for this command.  When a program is executing the progress can be 
checked by looking at the Operations Window, the command being processed will have it’s 
tick mark highlighted in blue. On simple programs this may happen so quickly that it cannot 
be seen. 

 

Execute - Stop Program 
 

The stop program buttons on the top toolbar and on the status panel are shortcuts 
for this command. 

Stops the execution of the program simulation. Note that this button is only available if a 

simulation is actually running. The button on the Status Panel is the same as this 
command. The Continue Program command on the Execute menu can be used to continue 
execution of a program that has been stopped. 

 

Execute - Single Step 
 

This button sets the simulation to single step mode. Every time you press the Execute button, 
only the next operation in the sequence will be carried out. Note that a Tool Definition or a 
Tool Select command is counted as an operation.  

The single step button on the top toolbar is a shortcut for this command. 

If you want to move the tool WITHIN AN OPERATION from point to point, select the 
Execute - Pause Mode  

 

Execute - Pause Mode 
 

This button sets the simulation to pause mode. Every time you press the Execute button on 
the Status Panel, the tool is moved to the next geometry position within the operation. 

  Press this button to start the pause mode simulation. 
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 The button will turn RED and Flash, press the button to see the next 
tool movement. Only press this button once and wait for the tool get to it’s 
new position before pressing again. You can’t “store” hits. 

Note: This is not the same as Single Step mode which, upon activation of the Execute 
button, will carry out a complete single operation. See Execute - Single Step. 

To switch off Pause mode use the Execute menu item and untick Pause Mode, the 
system will revert to full run mode. 

 

Execute - Slower 
 

The slower button on the top toolbar and the Simulation Speed control on the 
status panel are shortcuts for this command. 

Selecting this command when a program simulation is running will have the effect of slowing 
down the simulation 

 You may also use this button on the Status Panel 

  

Execute - Faster 
 

The faster button on the top toolbar and the Simulation Speed control on the status 
panel are shortcuts for this command. 

Selecting this command when a program simulation is running will have the effect of speeding 
up the simulation.  

 You may also use this button on the Status Panel 
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Execute - Post Process 
 

The post process button on the operations toolbar is a shortcut for this command. 

 
When you have completed and debugged you program, you will then need to produce a file 
with the NC code necessary for the machine tool. This is accomplished by means of a post 
processor. The required post processor can be selected by means of the dialog shown above. 
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File Menu 
 

 

  

This menu contains commands to do with opening, closing, saving and printing files.  

 

 

File - New 
 

The button on the Top Toolbar is a shortcut for this command 

The File - New command opens a new program. If a program is already open you will be 
asked if you wish to save it before the new program is started. 

 

File - Open 
 

The button on the Top Toolbar is a shortcut for this command 

The File - Open command is used to load an existing PartMaster program in a new window. 
There is no restriction on how many programs that you may load. The program that is the 
currently active program may be selected by means of the Window Menu or by clicking 
anywhere within the display if more than one program is displayed. How the various programs 
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are displayed is controlled by the options on the Window menu. A preview panel on the dialog 
will show the geometry of the currently selected file as a help in selecting the correct program. 

The following dialog is displayed: 

 
The dialog will automatically be set to the My Documents\PartMaster\Drawings folder. If the 
drawing that you wish to load is not in this folder, use the arrow button to open the complete 
directory, where you can select the folder that you want. Select the file name that you wish to 
open and then click on the Open button. Under the Windows XP operating system you will 
also see an extra toolbar at the left which contains entries such as My Recent Documents etc. 

 

File - Save 
 

The button on the Top Toolbar is a shortcut for this command 

The File - Save command saves the current program to the name and directory previously 
assigned without further comment. If the program has not been saved previously, the File - 
Save command is equivalent to the File - Save As command which will ask you to choose a 
folder and enter a name for the drawing. See File - Save As 
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File - Close 
 

The File - Close command closes the currently selected program file. If the program has not 
been saved previously or it has been altered since it was opened, you will be asked if you 
wish to save the file before it is closed. Note that this operation does NOT exit Partmaster - 
the program will remain open and active. If any other programs are currently loaded, the next 
one on the list will become the active program.  

 

File - Save As 
 

The File - Save As command is used to save the current drawing to a name or folder different 
to that which is currently assigned. 

The following dialog will be displayed: 
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File - Import 
 

The File - Import command is used to load an existing program or drawing. The file types 
currently available are PartMaster drawings, Dolphin CAD version 4 drawings, DXF drawings 
and machining programs written in Dolphin CAM version 4. 

The following dialog is displayed: 

 
The dialog will automatically be set to the My Drawings folder. If the file that you wish to load 
is not in this folder, use the mouse to open the complete directory, where you can select the 
folder that you want. Select the file name that you wish to open and then click on the Open 
button. 

DXF IMPORT - When you import a DXF file, the elements within the drawing will be 
handled in the following manner:  

• The drawing is scanned for POLYLINE features which have been imported as 
"Contours" on the layer "PartMaster", if none are found, the system attempts to create 
"Contours" from the available geometry.  
This means that if the drawing has been prepared beforehand by using POLYLINE's 
to identify the geometry to be imported, then the system will import only the prepared 
geometry, otherwise it will attempt to import all available geometry. (Maybe including 
the drawing frame and other undesired features).  

• It is useful to note that if the export software that produced the DXF file has the option 
to select Version 12 DXF then this is the recommended choice as this option will 
export any NURBS as basic elements (lines, arcs etc) which can be handled within 
Dolphin CAM for machining.  

• All suitable geometry is imported and assigned names based on the drawing name, 
e.g. Drawing1_CURVE001, Drawing1_CURVE002 etc. This allows geometry to be 
imported from multiple drawings without creating a naming conflict.  

If complex drawings (containing text, help lines, frames etc.) are imported with no 
attempt to simplify the geometry held within them, the import routine may well find that 
the geometry cannot be resolved in a satisfactory manner. In these cases the 
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recommended procedure is to open the DXF file within the Dolphin CAD system and 
simplify the drawing as required. 

 

File - Export 
 

The File - Export command is used to save the current program in a range of external formats 
(other than PartMaster). The file types currently available are PartMaster CAM files version 
6004, Windows enhanced Metafile, and Text Files 

The following dialog is displayed: 

 
The dialog will automatically be set to the My Drawings folder. If this is not the folder where 
you wish to save the data, use the mouse to open the complete directory, where you wish to 
save the data. Input the file name that you wish to use and then click on the Save button. 

 

File - Print 
 

The button on the Top Toolbar is a shortcut for this command 

The File - Print command sends the selected output to the printer. A dialog will be opened 
where you can select the printer to be used (from the installed printers), the print parameters 
to be used and also what you want to send to the printer. 
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What do you want to print: With this field you can select what you wish to print out 

Edit Layout: This button enables you to set exactly what will printed as part of the document 
that you have selected.  

 

File - Print preview 
 

The Print Preview command opens a new window which will display how the program will 
look when it is printed with the current printer settings. The display will change according to 
the data that you have selected to print in the Print command. 

 
When you wish to revert to the normal Dolphin CAM window, click on the Close button. 

 

 25



File - Send NC Program to... 
 

The File - Send NC Program to command is used to send the current NC program (after it has 
been post processed) to a machine tool controller. The target is set to that specified in the 
selected cfg program. The cfg (configuration program) is set within the DComms module and 
specifies the target port (COM1, COM2 etc.), the baud rate, data bits, stops bits and 
handshaking protocol to be used in the data transfer. 

The following dialog is displayed: 

 
The dialog will automatically be set to the Applications Data folder. If the drawing that you 
wish to load is not in this folder, use the arrow button to open the complete directory, where 
you can select the folder that you want. Select the configuration program that you wish to use 
and then click on the Open button. 

For further information please see the PartMaster Communications (Dcomms) program and 
Help files. 

 

File - Send as Mail 
 

The File - Send as Mail option is used to send the current CAM file *.cnc to your resident 
Email program such as Outlook or Outlook Express. 
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Setup Menu - Turning 
 

 
This menu contains commands which enable you to define the machine type (mill, lathe, 
edm), to define any fixture offsets (milling & edm only), and to define a billet (raw material 
block). You can also save these definitions and reload a stored setup if required. 

Setup - Machine Type - Turning 
 

The button on the Operations Toolbar is a shortcut for this command. 

Setup is the first command which must be carried out when beginning a new program - when 
you enter PartMaster or when you activate the File - New command most other menu 
commands and buttons will be disabled. The Setup dialog is used to set up the basic 
parameters which will apply to the new program. The Setup dialog will be displayed: 

 
As you can see the dialog has 6 folders, the first one which will be displayed automatically is 
the one headed Machine Type. In this page you must select the type of machine to be used  
and the units that will be used within the program (Millimetres will be pre selected). 
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If you select a Two or Four Axis Lathe as the machine type then the bottom part of the 
dialog will have a panel where you must select either Radius or Diameter programming, 
together with the name of the drawing which defines the tailstock (if required). 

NOTE ! The Radius and Diameter programming mode controls only how 
data entered within the CAM is expressed, it does NOT control what to 
output to the machine tool controller. This is handled by the Post-
processor 

 If you enter values and the click on OK button the dialog will be closed. If you wish to 
enter values on various pages and activate them whilst remaining within the dialog, 
use the APPLY button. 

 

Setup - Machine Type - Program ID 
 

 
In this page you can enter a part number or ID of the program in order to identify the job more 
easily. This name or number can be output with the NC code as a comment if the post 
processor is set up to do this. 

The NC program number is the program number that will be output at the start of the NC 
code. 

Neither of these names or numbers are connected with the file name under which the 
program will be stored on the hard disk. 

Note: If you enter values and the click on OK button the dialog will be closed. If you 
wish to enter values on various pages and activate them whilst remaining within the 
dialog, use the APPLY button. 
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Setup - Machine Type Turning - Tool Change 
 

 
Tool Change Position/Safe (Home Position 
This field defines the position to which the machine will go in order to carry out a manual tool 
change. If the machine has an auto tool changer then this position will probably be ignored by 
the postprocessor BUT it is still sensible to enter figures that are approximately correct 
because they will be used in the graphic display. The Safe (Home) Position defines a position 
to which the tool can be sent when you wish to ensure that it is clear of the job. This function 
can be accessed via the Goto function  

Two sets of figures can be input, one for the rear turret and one for the front turret - fill in one 
or both of these depending upon the configuration of the lathe. 

Spindle Speed 
This field is used to specify a maximum spindle speed for the machine when you are 
programming using constant surface speeds. Otherwise, if the tool approaches the centre line 
of the job, an improbably high spindle speed may be attempted. 

Clearance Distance for Canned Cycles 
This field is used to set the distance away from the workpiece at which the feedrate will 
change from rapid to the programmed rate when the tool approaches the job at the start of a 
canned cycle. 

Tick Boxes 
The tick boxes at the bottom of the page allow you set a spindle stop and to switch the 
coolant off at every tool change. Whether these are necessary depends upon the machine 
tool controller. Many machines will automatically carry out these steps as soon as a tool 
change is commanded, others require a specific command.  

Note: If you enter values and the click on OK button the dialog will be closed. If you 
wish to enter values on various pages and activate them whilst remaining within the 
dialog, use the APPLY button. 
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Setup - Machine Type - Vector Tolerance 
 

 
Vector Tolerance: The Vector Tolerance is used by PartMaster to turn arcs and other curves 
such as splines, which the machine tool controller cannot handle, into a series of small linear 
moves approximating the shapes defined. The smaller the vectors the more nearly they 
approach the perfect form. Using an extremely small vector tolerance will produce a shape 
which requires little finishing but which may have many thousands of NC blocks. It is easily 
possible to exceed the size of a single program which is allowed by the NC controller - in this 
case it may be necessary to machine the form in DNC mode by drip feeding the controller 
from the computer. The Vector Tolerance sets the maximum value by which the linear moves 
(i.e. the vertices) may deviate from the perfect curve.  

Note: If you enter values and the click on OK button the dialog will be closed. If you 
wish to enter values on various pages and activate them whilst remaining within the 
dialog, use the APPLY button. 

 

 30



 

 

Setup - Machine Type - Origin 
 

 
Origin 
The origin is used to define the machine tool zero point relative to the geometry origin and will 
typically appear in a G92 block. For lathes the only sensible input here is an X value which 
will have the effect of moving the machining along the X-axis. 

Work Offset Register 
The work offset register is typically used by the post processor to create a G54, G55..... block. 
Offset register 1 = G54, 2 = G55 etc. The exact output depends upon the post processor 
settings. This function is normally used on milling machines where several workpieces may 
be mounted at different positions on the machine table. 

Note: If you enter values and the click on OK button the dialog will be closed. If you 
wish to enter values on various pages and activate them whilst remaining within the 
dialog, use the APPLY button. 

This command is primarily for Milling. 
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Setup - Machine Type - Extra Info 
 

 
Extra Info 
The Extra Info command allows you to define NC blocks which are output at the start of the 
program after the program number but before any machining instructions. Note that these 
entries will NOT be acted upon by the post processor so they must contain valid NC code for 
the controller in question.  

Note: If you enter values and the click on OK button the dialog will be closed. If you 
wish to enter values on various pages and activate them whilst remaining within the 
dialog, use the APPLY button. 

 

 

Setup - Fixture Offsets - Turning 
 

NOTE: This command is meaningless within the Turning module and applies only to 
milling operations.     
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Setup - Reset - Turning 
 

This command enables you to selectively delete parts of an existing program. Upon choosing 
this command you will be asked consecutively if you wish to delete all the tools from the 
program, all the machining commands from the program or all the geometry from the 
program   

Setup - Billet - Turning 
 

This command enables you to define a billet (blank) for turning. The command is not available 
if the Machine Type is set to a milling machine. 

   

A  non-cylindrical billet such as a casting can be defined by means of a profile which you can 
choose from within the list of defined geometric elements in the lower part of the dialog. A 
billet which is defined by a profile can be accessed in the Face/Turn dialog and used as an 
outer limit to the machining, thus reducing unwanted air cutting.    

 

To view the Billet the Tool drawing option must be set to this option. 

The toolpath is shown as full 
simulation of the cutter. The blank 
material is shown as a filled body 
which is removed as the cutter path is 
simulated. This option is the nearest to 
a full visual re-creation of the turning 
process.  

The button on the main toolbar is a 
shortcut for this option.  

  

 

 

Having set the tool drawing option you must re-draw   the screen to see the Billet. 
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Setup - Load Setup - Turning 
 

This command enables you to re-load a set of Setup parameters previously stored with the 
Setup - Save Setup command. The standard File Open dialog is displayed with the default 
folder set to Application Data and the file type set to *.mcn (machine tool information file). 
 

Setup - Save Setup - Turning 
 

This command enables you to save a set of Setup parameters previously defined with the 
commands on the Setup menu. In addition to the normal setup parameters, this command will 
also save all the cutters that have been defined within the program. 

The standard File Save dialog is displayed with the default folder set to Application Data and 
the file type set to *.mcn (machine tool information file).    
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TOOLING 
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Tooling - Define Turning Tool 
 

The button on the Operations Toolbar is a shortcut for this command 

 
The Define Tool dialog allows you to define turning tools of six different kinds as shown 
above. Drilling tools (drill, reamer, tap, End mill etc.) are defined in a separate dialog which 

is accessed via the button on Operations Toolbar. See Define Drill Tool  

Tool Dimensions: The fields that are applicable here depend upon the type of tool that is 
chosen.  

The Cut Depth field specifies the actual cutting depth which the cutter is capable of. If no 
Cutdepth is entered into any of the machining operations which use this tool, the cutting 
depth will default to this value. The Cutdepth value may be overwritten in the machining 
dialogs.   

Turret: The Turret may be either Front or Rear mounted. The Z and X-axis offsets are used 
for those NC machines which require co-ordinate data referred to some datum other than the 
tool datum, e.g. a turret datum point. In this case the Z and X tool offsets must be entered into 
the Define Tool dialogue. The tool offsets are the distances in Z and X from the tool datum to 
the turret datum. For lathes with two turrets mounted on a single cross slide, this feature can 
be used to refer all tools on both turrets to a single datum point. On lathes that expect the tool 
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datum co-ordinates together with Z and X tool offsets, the offset registers are programmed in 
the Tooling - Select Tool dialogue. See Tooling - Select Tool 

Hand: This defines in which direction the cutter approaches the job, i.e. they cut from Right 
to left or from Left to right along the Z axis. Neither means that it is irrelevant and applies to 
symmetrical tools such as thread cutters. 

Approach: Defines if the tool approaches the job from the front or the rear - it has NO 
connection with the position of the turret - a tool mounted on a rear turret may nevertheless 
approach from the front. 

The Description field will contain a short description of the tool type chosen. You can edit or 
delete this description and write in your own description as desired. 

The Tool Number field defines the number of the tool in the program. Tools do not have to be 
defined or selected in any particular order. The length and offset register numbers are set in 
the Select Tool dialog. See Select Tool  

The Drawing Name field allows you to access a PartMaster CAD drawing which defines the 
tool geometry. This is necessary if you wish the on-screen simulation to be done with a full 
drawing of the tool (including shank etc.), otherwise only the tool tip geometry as defined in 
the Tool Dimensions fields can be shown. Click here for further details about preparing a 
drawing which defines the tool geometry The drawings are stored in a sub-folder of the 
PartMaster System called Application Data. 

 

Tooling - Definitions 
 

 
As each tool is defined it is added to the bottom of the list in the Tooling Definitions Pane. 
You can re-set the size of this pane to the full window size by means of the Tooling 
command in the Window Menu. The Tile command in the same menu will set all the panes 
within the display window back to the default configuration. 

Edit a Tool Definition 
To edit an existing definition, double click on the entry with the left hand mouse button. The 
Dialog that defines the tool will be displayed showing all the values and parameters that you 
originally set. Make any necessary alterations and then click on OK. Note that the alterations 
will NOT be carried out until the program has been executed after the alteration.  

Delete Tool Definition 
To delete an operation from the sequence simply click on the text part of the entry and hit the 
delete key on the keyboard or select Delete from the Edit Menu. 

See Also: Define Turning Tool & Define Milling Tool 
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Bore Tool 
A Bore tool is used for internal turning operations. The tool dimensions are as follows: 

 

PRIMARY ANGLE Measured anti-clockwise from the Z-axis round to the primary cutting 
face 

INCLUDED 
ANGLE Measured anti-clockwise from the primary to the secondary cutting face 

TIP RADIUS The radius of the tool tip 

Z TIP OFFSET The distance from Z zero to the centre of the tip radius 

X TIP OFFSET The distance from X zero to the centre of the tip radius 

NOTE: Regardless if the tool is mounted on a front or rear turret or approaches the job 
from left or right, the tool geometry is always defined in the quadrant shown above. 
PartMaster will make any necessary adjustments for other quadrants. 
 
 

Button Tool 
This option defines a tool which may be used for all Turn, Bore, Groove or Trepan operations 

 

PRIMARY ANGLE Anti-clockwise from the Z-axis to the primary cutting face - normally 270 
degrees 
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INCLUDED 
ANGLE Not-Applicable 

TIP RADIUS The radius of the tool tip 

Z TIP OFFSET The distance from Z zero to the centre of the tip radius   

X TIP OFFSET The distance from X zero to the centre of the tip radius 

NOTE: Regardless if the tool is mounted on a front or rear turret or approaches the job 
from left or right, the tool geometry is always defined in the quadrant shown above. 
PartMaster will make any necessary adjustments for other quadrants. 
 

Drill 
The button on the Operations Toolbar is a shortcut for this command 

 
The Define Drill Tool dialog allows you to define turning tools of seven different kinds as 
shown above.  

Tool Dimensions: The fields that are applicable here depend upon the type of tool that is 
chosen. All these tools are intended for axial operations along the machining centre line and 
thus the geometry is reduced to a diameter and length. The Lead is the distance from the 
point of a drill to the position where it reaches full diameter. This figure is automatically 
calculated and entered as one third of the diameter if the tool type is specified as Drill. All 
hole depths in drilling cycles will be adjusted by this amount unless the option is suppressed 
in the cycle definition dialog. See Machining - Drill 

The Cut Depth field specifies the actual cutting depth which the cutter is capable of. For tools 
of this type it is intended for guidance only and will be ignored by the machining cycle.    

The Description field will contain a short description of the tool type chosen. You can edit or 
delete this description and write in your own description as desired. 
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The Tool Number field defines the number of the tool in the program. Tools do not have to be 
defined or selected in any particular order. The length and offset register numbers are set in 
the Tooling - Select Tool dialog. See Tooling - Select Tool  

The Drawing Name field allows you to access a PartMaster CAD drawing which defines the 
tool geometry. This is necessary if you wish the on-screen simulation to be done with a full 
drawing of the tool (including shank etc.), otherwise only the tool tip geometry as defined in 
the Tool Dimensions fields can be shown. 

Turret: The Turret may be either Front or Rear mounted. The Z and X-axis offsets are used 
for those NC machines which require co-ordinate data referred to some datum other than the 
tool datum, e.g. a turret datum point. In this case the Z and X tool offsets must be entered into 
the Define Tool dialogue. The tool offsets are the distances in Z and X from the tool datum, to 
the turret datum. For lathes with two turrets mounted on a single cross slide, this feature can 
be used to refer all tools on both turrets to a single datum point. On lathes that expect the tool 
datum co-ordinates together with Z and X tool offsets, the offset registers are programmed in 
the Tooling - Select Tool dialogue. See Tooling - Select Tool  

 

Groove Tool 
A Groove tool is used for radial plunge operations on the outside diameter of the workpiece. 

The tool types that are defined with this definition include part-off tools as well as groove tools 
(with or without corner rads) and round button type tools. The tool dimensions are as follows: 

 

PRIMARY ANGLE Anti-clockwise from the Z-axis to the primary cutting face - usually 270 
deg. 

INCLUDED 
ANGLE 

Anti-clockwise from the primary to the secondary cutting face - usually 0 
deg. 

TIP RADIUS The radius of the tool tip if any 

Z TIP OFFSET The distance from Z zero to the centre of the tip radius 

X TIP OFFSET The distance from X zero to the centre of the tip radius 

NOTE: If the Cycle Type on the machining dialog is set to Plunge Cutting the Cutdepth 
parameter is used only for the graphic display - it will not be checked by PartMaster 
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NOTE: Regardless if the tool is mounted on a front or rear turret or approaches the job 
from left or right, the tool geometry is always defined in the quadrant shown above. 
PartMaster will make any necessary adjustments for other quadrants. 

 

Thread Tool 
This option defines tools used for either internal or external threading operations. The tool 

dimensions are as follows: 

 

PRIMARY ANGLE Anti-clockwise from the Z-axis to the primary cutting face 

INCLUDED ANGLE Anti-clockwise from the primary to the secondary cutting face 

TIP RADIUS The radius of the tool tip if any 

Z TIP OFFSET The distance from Z zero to the centre of the tip radius, normally 0 

X TIP OFFSET The distance from X zero to the centre of the tip radius 

NOTE: Because the tool is symmetrical about the X axis, the Z axis tip offset is zero. Either 
edge can be used as the primary edge, provided that the primary and secondary angles are 
consistent. Normally the primary edge is the one that is cutting when the tool move towards 
the chuck in the Z axis.  

NOTE: Regardless if the tool is mounted on a front or rear turret or approaches the job 
from left or right, the tool geometry is always defined in the quadrant shown above. 
PartMaster will make any necessary adjustments for other quadrants. 
 

 

Trepan Tool 
A Trepan tool is used for axial plunge operations on the face of the workpiece. The tool types 
that are defined with this definition include trepan tools (with or without corner rads) and round 

button type tools. The tool dimensions are as follows: 
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PRIMARY ANGLE Anti-clockwise from the Z-axis to the primary cutting face - usually 0 deg.

INCLUDED 
ANGLE 

Anti-clockwise from the primary to the secondary cutting face - usually 0 
deg. 

TIP RADIUS The radius of the tool tip if any 

Z TIP OFFSET The distance from Z zero to the centre of the tip radius 

X TIP OFFSET The distance from X zero to the centre of the tip radius 

NOTE: If the Cycle Type on the machining dialog is set to Plunge Cutting the Cutdepth 
parameter is used only for the graphic display - it will not be checked by PartMaster 

NOTE: Regardless if the tool is mounted on a front or rear turret or approaches the job 
from left or right, the tool geometry is always defined in the quadrant shown above. 
PartMaster will make any necessary adjustments for other quadrants. 
 
 

Turn Tool 
A Turn tool is used for general facing and turning operations. The tool dimensions are as 

follows: 

 

PRIMARY ANGLE Measured anti-clockwise from the Z-axis round to the primary cutting 
face 

INCLUDED 
ANGLE Measured anti-clockwise from the primary to the secondary cutting face 

TIP RADIUS The radius of the tool tip 

Z TIP OFFSET The distance from Z zero to the centre of the tip radius 
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X TIP OFFSET The distance from X zero to the centre of the tip radius 

NOTE: Regardless if the tool is mounted on a front or rear turret or approaches the job 
from left or right, the tool geometry is always defined in the quadrant shown above. 
PartMaster will make any necessary adjustments for other quadrants. 
 
 
 

 

Tooling - Load Toolfile 
 

This command allows you to re-load a toolfile which has previously been saved with the 
Tooling - Save toolfile command. 

This is particularly useful for turning if you have tool turrets which are always loaded with a 
range of standard tools, or for milling when a tool changer or carousel has a range of 
standard cutters in pre-defined positions. 

The Open dialog is opened with the file name extension *.tlf and the default folder set to 
Application Data. 
 

Tooling Menu - Turning 
 

  

  
This menu contains commands which enable you define and select tools 
 

Tooling - Save Toolfile 
 

All the tool definitions in the current program can be saved to a toolfile which can then be re-
loaded into another program for future use. This is particularly useful for turning if you have 
tool turrets which are always loaded with a range of standard tools, or for milling when a tool 
changer or carousel has a range of standard cutters in pre-defined positions. 

The Save dialog is opened with the file name extension *.tlf and the default folder set to 
Application Data 
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Tooling - Select Turning Tool 
 

The button on the Operations Toolbar is a shortcut for this command 

 
The drop down list at the top of the dialog shows all the available tools which have been 
defined. 

The Z-Offset Register and X-Offset Register fields refer to the offset registers of the NC 
machine, they may or may not be the same as the tool number. 

Spindle Control: This part of the dialog controls the spindle speeds. You may set  a 
Constant Spindle Speed (conventional) or you can set a Constant Surface Speed. If you 
set a Constant Surface Speed the Maximum Spindle Speed field allows you to set a 
maximum in case the machine tries to reach some dangerously high speed when the cutter 
approaches the centre line of the workpiece.  
Spindle speed may also be set independently of a tool change by means of the menu field 

Machining - Spindle or via the button on the Miscellaneous Toolbar. 

Feedrate: may be output as Feed per minute (conventional) or as a Feed per Revolution 

Coolant may be switched ON automatically after the tool change. Note that you may switch 
the coolant on and off independently of a tool change by means of the menu field Machining 

- Coolant or via the button on the Miscellaneous Toolbar. 

The Select Tool dialogue may also used to set a new spindle speed and direction, a new 
cutting feedrate and to switch coolant ON or OFF. A tool change sequence is initiated only if 
the tool number entered is different to the currently selected tool, otherwise only the new 
spindle speed, feedrate and coolant settings are sent to the post-processor. 
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Machining - Drill 
 

The button on the Operations Toolbar is a shortcut for this command 

Although entered on the Menu as Drill, Canned Cycles include all the various types of drilling, 
reaming, boring and tapping cycles. Although they are called canned cycles the way that they 
are output to the NC machine is dependant upon the post processor setup. This means that it 
is possible to define a cycle which the NC machine does not have built in and have it output 
as a series of individual movement commands. It is however usual to use the built in canned 
cycles on the NC machine wherever possible in order to keep the program length to a 
minimum. 

 

  

CYCLE TYPE DESCRIPTION 

DRILL Feed to depth, retract at rapid. - Can be used with tools 
defined as either MILL or DRILL.  

DEEP DRILL Drill hole in a series of pecks, retracting tool completely 
between each peck.  

PECK DRILL Drill hole in a series of pecks, retracting tool slightly between 
each peck. The number of pecks is entered in the dialogue. 
PartMaster calculates the depth of each peck 

REAM Feed to depth, retract at feedrate. Can only be used with 
REAM type tools 

BORE Feed to depth, spindle stop, retract at feedrate, spindle start. 
Can only be used with DRILL tools.  

TAP Feed to depth, reverse spindle, retract at feedrate, reverse 
spindle. Can only be used with TAP type tools. 

Each of the cycles can be modified according to which options are ticked in the dialogue box.  
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OPTION DESCRIPTION 

Dwell before 
retract 

Use drill with dwell canned cycle, the dwell time must also 
be entered in the dialogue.  

Do not reverse 
tap 

For Tap cycle only: Do not reverse tap when retracting - 
usually because the Tap holder reverses automatically. 

Rapid Infeed for 
Deep Drill 

If a deep drill cycle is selected, ticking this options causes 
the tool to descend at rapid feedrate, to a point just above 
the previous depth drilled, after retracting to clear swarf from 
the hole being drilled. 

Ignore tool's 
lead value 

The distance from the point of a drill to the point where it 
reaches full diameter is called the lead (see Tooling - 
Define Drill). Any drill depth is normally adjusted so that the 
hole depth applies at the full diameter not the point of the 
drill. If this option is ticked, this calculation is ignored and the 
tip of the drill is sunk to the defined depth. 

The Pattern Name field is greyed out for Turning as all these operations are performed on 
the workpiece centreline. 

Z-PLANES DESCRIPTION 

FEED CHANGE 
PLANE 

Defines a position above the Work Surface to which the tool 
moves at Rapid Speed before changing to the programmed 
feedrate for the cycle. 

WORK 
SURFACE 

Defines the Z axis position at which the cycle starts relative 
to the workpiece zero 

DEPTH OF 
HOLES 

Defines the depth of the cycle as measured from the Work 
Surface. Depths are always positive into the job. 
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Machining - Goto 
 

The button on the Operations Toolbar is a shortcut for this command 

Goto is the only command (apart from Digitise) provided for driving the tool directly. All other 
commands drive the tool with respect to some piece of pre-defined geometry. 

 
Goto 
Send Tool to Home Position: This command sends the tool to the Safe (Home) position as 
defined on the Tool change Page of the Setup dialog. 
See Setup - Machine Type - Tool change  

Goto: Sends the tool to a specific XZ co-ordinate. A click on the button enables you to 
use the cursor to pick a position on the screen directly without having to know the exact co-
ordinates. The dialog will be temporarily removed and the cursor will be placed in the display 
screen. Move the cursor to the required position and click with the left hand mouse button. 
The dialog will re-appear with the co-ordinates of the indicated position entered in the 
appropriate fields. 

Options: 
The Options tick boxes allow you to alter the way that the move is executed. The Goto move 
may be made at rapid feedrate if the Rapid Feedrate box is activated, otherwise it will be 
made at the current feedrate. If the Incremental tick box is activated the XZ co-ordinates will 
be taken as an incremental move from the current position. The other three options specify 
how the move is to be made - in two axes simultaneously or Z followed by X or X followed by 
Z. These options can be important in moving the tool clear from the job before the final 
position is reached. 

Caution is needed with the Goto command as the move will NOT be checked for 
collisions! 
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Machining - Groove/Trepan 
 

The and the buttons on the Operations Toolbar are shortcuts for this command 

This command enables you to define a cycle to machine grooves in the diameter of the job 
(Groove) or in the face of the job (Trepan). The basic cycle which is defined by the co-
ordinates of two opposite corners can be modified so that a profile (usually the finished part) 
is used as a limit to the machining. The Cutdepth specifies the in-feed between successive 
passes of the cutter. The program will default to the Cutdepth value specified in the tooling 
Definition. See Tooling - Tool Definition  

 
    

CYCLE 
LIMITS 

These fields enable you to define two diagonally opposite corners 
of the area to be covered by the cycle. The two corners may be 
given in any order - top right/bottom left - bottom right/top left - top 
left/bottom right - bottom left/top right. If the cycle is not modified 
in any other way a simple area clearance will be performed 
between these limits. The extent of the cycle may be modified by 
a limiting (protected) profile - normally that of the finished part. If 
the groove is defined by simple ZX co-ordinates the bottom part of 
the dialog can be used to define lip or root fillets or radii.  

The button enables you to use the cursor to pick a position 
on the screen directly without having to know the exact co-
ordinates. If you click on the button, the dialog will be temporarily 
removed and the cursor will be placed in the display screen. Move 
the cursor to the required position and click with the left hand 
mouse button The dialog will re-appear with the co-ordinates of
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the indicated position entered in the appropriate fields. If you hold 
down the Shift key when you click on the screen position, the 

cursor will change to a and PartMaster will pick up the exact 
co-ordinates of the nearest geometry point, either of the blank or 
the part profile 

The cycle can be modified according to which options are ticked in the dialogue box. 

CYCLE 
TYPE DESCRIPTION 

External The cycle will be carried out on the external diameter of the 
workpiece. i.e. the feed will be from outside towards the centre line.  

Internal The cycle will be carried out on an internal diameter of the workpiece. 
i.e. the feed will be from the centre line towards the outside.   

Radial - 
Groove  

Axial - 
Trepan 

The cycle will consist of a series 
of cuts along the Z-axis with the 

feed in direction in the X-axis 

 

GROOVE 

The cycle will consist of a series of 
cuts along the X-axis with the feed 

in direction in the Z-axis. 

 
TREPAN 

If this option is chosen the cutting cycle is changed so that it consists 
of a series of plunge cutting moves rather than a series of axis parallel 
cutting moves. 

Use 
Plunge 
Cutting 

GROOVE - PLUNGE 

 
TREPAN - PLUNGE 

Retract 
at At the end of each cutting pass the tool is retracted and moved to the 

t t f th t Thi t t i ll d t id
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Feedrate start of the next pass. This retract move is normally made at rapid 
feedrate but if you select this option it will be made at the programmed 
cutting feedrate instead. 

 

 

                 

CHECK 
SURFACE 
PROFILE 

CHECK SURFACE PROFILE: A profile name entered here 
will be used as a limiting (protected) profile to amend the 
machining as defined by the simple XZ co-ordinates (see 
above). Any profile may be chosen as a check surface and 
this means that a groove or trepan cycle does not have to be 
applied to a regular rectangular form - any shape can be 
machined provided that the cutter tip geometry is suitable for 
the job. The area will first be semi-roughed out and then 
finished with a bi-directional profiling operation.  

 

The button enables you to use the cursor to pick either of 
the above profiles directly from the screen. If you click on the 
button, the dialog will be temporarily removed and the cursor 
will be placed in the display screen. Move the cursor over the 
required profile and click with the left hand mouse button. The 
dialog will re-appear with the name of the profile entered in 
the appropriate field. 

FINISH 
ALLOWANCE 

The Finish fields allow you to define a different finishing 
allowance for both the Z and X axes. This is the amount of 
material that will be left on the part profile for finishing 
operations. 

            

LEFT - RIGHT  

LIP OR ROOT 

FILLET OR 
CHAMFER 

If you have defined the groove or trepanning cycle with simple 
ZX co-ordinates with no reference to a check surface profile, 
these fields allow you to define a fillet radius or chamfer at the 
lip or root of the detail at either or both the right and left hand 
side. 
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Machining Menu - Turning 
 

 
This menu contains commands which enable you define machining commands.  

NOTE: The actual output of many of the miscellaneous operations in the lower part of 
the menu are completely dependant upon the post processor settings! 
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Machining - Profile Turn 
 

The button on the Operations Toolbar is a shortcut for this command 

This command enables you to drive the cutter along a defined profile. It is usually used for 
finishing operations.   

TYPICAL PROFILE TURN CYCLE 

 

      To see details of the options on page two (Options) of this dialog, click on the 
appropriate part of the graphic above. 

 

PROFILE 
NAME 

This field allows you to enter the name of the profile that is to be 
machined. The drop-down list will show all the profiles that are 
currently defined within the job. 

The button enables you to use the cursor to pick the profile 
directly from the screen. If you click on the button, the dialog will 
be temporarily removed and the cursor will be placed in the 
display screen. Move the cursor over the required profile and click 
with the left hand mouse button. The dialog will re-appear with the 
name of the profile entered in the appropriate field. 

The cycle can be modified according to which options are ticked in the dialogue box. 
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CYCLE TYPE DESCRIPTION 

External The cycle will be carried out on the external diameter of the 
workpiece. i.e. the feed will be from outside towards the 
centre line.  

Internal The cycle will be carried out on an internal diameter of the 
workpiece. i.e. the feed will be from the centre line towards 
the outside.   

Finish The Finish fields allow you to define a different finishing 
allowance for both the Z and X axes. This is the amount of 
material that will be left on the part profile for further finishing 
operations. 

                 

MACHINING 
DIRECTION The machining direction may be specified as either Forward 

or Reverse. This refers to the direction of the profile as 
defined by the geometry. 

Approach and Runoff determine how the tool will attach to the shape to be machined, the 
point at which the tool will begin the cutting process and the point at which the tool will retract. 
There are 4 options : 

TYPE DESCRIPTION 

NONE No approach / runoff - the tool simply attaches to the profile 
or retracts from the profile at the point specified by the start 
and end points as defined on the Options page of the 
dialog.   

NORMAL The tool descends (approach) or retracts (runoff) from a 
point on a line at right angles to the first span to be 
machined. The length of this line is specified by the 
approach / runoff distance  

 

ARC An ARC approach produces a line followed by an arc which 
is tangential to the first span to be machined. A Runoff 
move produces an arc followed by a line.  
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PARALLEL The approach / runoff move is made by extending the first / 
last span to be machined by an amount equal to the 
approach / runoff distance specified.  
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Machining - Profile Turn - Options 
 

The second page of the Profile Turn dialog enables you to set further options to the standard 
cycle.   

 

 

PARTIAL MACHINING 

These fields allow you to select any part of the profile for machining as the start 
and end points of the cycle. 

NOTE: The simple ZX position defined by say Span 1, 100% is identical to that 
of Span 2, 0%. This does NOT mean that these two positions are treated 
identically within the cycle. If you define an Approach or Runoff at this position, 
how this is carried out will depend upon the span geometry. For example, an
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Approach position defined at the end of span 1 will not be the same as that 
defined by the start of span 2. 

These fields will always have the start and end points of the full profile as 
default values. i.e. if you change nothing, the whole profile will be profiled (or at 
least as much as the cutter geometry allows. 

Span number The span number refers to the number of the element 
within the profile. Spans are numbered sequentially in the 
definition direction starting with one. To display the span 
numbers within a profile on screen, use the View - 
Options - Span Numbers command 

Position This field defines (in %) the distance along the selected 
span. The start of the span is 0% (0), the middle of the 
span is 50% (0.5) and the end of the span is 100% (1).    

Distance This field defines a distance along the span from the 
Position defined by the above field. i.e. if you select span 
2, 0.5, 3mm as the start position of the profiling operation, 
machining will begin at a position which is 3mm past the 
midpoint of span 2 as seen in the defined direction. If you 
wished to start machining at a point exactly 15mm along 
span 3 of the profile you could set the parameters as 
follows: Span 3, position 0, distance 15 

NOTE: Theoretically it is possible to define a distance here 
which will take the cutter beyond the end of the span. This 
will be collision checked against the profile and only carried 
out if the position does not interfere with other elements of 
the profile, otherwise machining will start (or end) at the 
end of the span. 

          

FURTHER 
OPTIONS DESCRIPTION 

Rapid Move 
from 

Current 
Position 

This option will move the tool from its current position to the start position 
of the cycle (as modified by any Approach moves) at rapid feedrate, 
otherwise it will be moved at the currently defined feedrate. 

Output Part 
Surface 

Coordinates 

Using this option will cause PartMaster to bypass its normal offsetting 
routines and output the finish part surface co-ordinates together with 
cutter radius compensation details, instead of outputting a corrected 
toolpath. (Finish allowance is still considered). 

This means that the offsetting routine is performed by the NC 
machine. There is no guarantee that the target machine tool can 
successfully cut the part 

Roll Tool 
around 
Sharp 

Corners 

PartMaster can machine external sharp corners either by rolling the tool 
around the corner or by extending the tool path to the intersection point. 
It defaults to rolling around external sharp corners.  

Stay out of 
Undercuts Depending upon the tool tip definition, the cutter may be able to partially 

machine re-entrant areas of the workpiece. Normally it will do this - if you 
do NOT wish it do so, tick this box 
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Machining - Threadcut 
 

The button on the Operations Toolbar is a shortcut for this command 

This command enables you to define threading cycles, both external (male) and internal 
(female).   

 

  

CYCLE 
LIMITS 

These fields enable you to define two diagonally opposite corners 
of the area to be covered by the cycle. The two corners may be 
given in any order - top right/bottom left - bottom right/top left - top 
left/bottom right - bottom left/top right.  

The button enables you to use the cursor to pick a position 
on the screen directly without having to know the exact co-
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ordinates. If you click on the button, the dialog will be temporarily 
removed and the cursor will be placed in the display screen. Move 
the cursor to the required position and click with the left hand 
mouse button. The dialog will re-appear with the co-ordinates of 
the indicated position entered in the appropriate fields. The dialog 
will re-appear with the co-ordinates of the indicated position 
entered in the appropriate fields. If you hold down the Shift key 
when you click on the screen position, the cursor will change to a 

and PartMaster will pick up the exact co-ordinates of the 
nearest geometry point, either of the blank or the part profile 

            

CYCLE TYPE DESCRIPTION 

External The cycle will be carried out on the external diameter of the 
workpiece. i.e. the feed will be from outside towards the 
centre line.  

Internal The cycle will be carried out on an internal diameter of the 
workpiece. i.e. the feed will be from the centre line towards 
the outside.   

           

FEEDRATE DESCRIPTION 

Feedrate The Feedrate for the cycle is entered in this field. The option 
boxes select which type of feedrate is being specified. Choose 
from Lead, Pitch or TPI  

Feed Angle This field specifies at which angle the feed-in between passes 
is made. It usually matches the flank angle of the thread but 
does not have to. Feed angle is measured positive anti-
clockwise from a line parallel to the X axis. A feed angle of 0.0 
will cause the tool to cut evenly on both flanks. Setting the 
feed angle to half the thread included angle will cause the tool 
to cut on one flank only.  

No. of Starts This specifies the number of starts that the thread has. If more 
than one start is specified, each start will be completely 
machines (roughing & finishing cuts) before the next is 
started. 

The cycle can be modified according to which options are ticked in the dialogue box. 

OPTION DESCRIPTION 

Thread Depth Thread depth is the total depth of the thread including 
roughing and finishing cuts. It is measured radially and is 
always positive. 

Thread Width .   
Runoff 

Distance 
Runoff Distance: If a non zero runoff distance is entered the 
tool will be retracted in the X axis while continuing to cut the 
thread in the Z axis. This value should usually be about the 
same value as the thread depth. 

Roughing 
Cuts  

Number of roughing cuts - Number of finishing cuts: The 
number of roughing cuts and the number of finishing cuts
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Finishing Cuts together determine the total number of passes used to cut the 
thread. PartMaster increments the depth uniformly for each 
roughing cut and each finishing cut. The increase in depth for 
all the finishing cuts together is equal to the increase in depth 
for one roughing cut. i.e. if the thread depth was 3mm and you 
specified 5 roughing cuts and 2 finishing cuts, each roughing 
cut would be 0.5mm deep and each finishing cut 0.25 deep. 
When specifying multi-start threads, each thread start will be 
completely machined before the next thread is started. 

          

Machining - Turn/Face 
 

The and the buttons on the Operations Toolbar are shortcuts for this command 

This command enables you to define general turning and facing cycles. The basic cycle which 
is defined by the co-ordinates of two opposite corners can be modified so that a profile 
(usually the finished part) is used as a limit to the machining. If a blank or billet is defined by 
means of another profile then machining can automatically be restricted to the area between 
this and the finished part profile. 

 
    

CYCLE 
LIMITS 

These fields enable you to define two diagonally opposite corners of the area 
to be covered by the cycle. The two corners may be given in any order - top 
right/bottom left - bottom right/top left - top left/bottom right - bottom left/top 
right. If the cycle is not modified in any other way a simple area clearance will 
be performed between these limits. The extent of the cycle may be modified 
by a limiting (protected) profile - normally that of the finished part. Note that 
although the defined limits may cross over the centre line of the job, 
machining will finish at the centre line (as modified by any offsets) A blank or
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billet may also be used to limit the machining if it has been defined by a 
profile definition.  

The button enables you to use the cursor to pick a position on the 
screen directly without having to know the exact co-ordinates. If you click on 
the button, the dialog will be temporarily removed and the cursor will be 
placed in the display screen. Move the cursor to the required position and 
click with the left hand mouse button. The dialog will re-appear with the co-
ordinates of the indicated position entered in the appropriate fields. If you 
hold down the Shift key when you click on the screen position, the cursor will 

change to a and PartMaster will pick up the exact co-ordinates of the 
nearest geometry point, either of the blank or the part profile.  

• When specifying the limits of a turn cycle, the coordinates you enter 
represent the diagonal of a rectangular shape.  

 

• Make sure that either the start or end point is actually in fresh air.  

• Make sure that the start point is more than (Tip Radius + Finish 
Allowance) away from the finish part profile in both Z and X  

• It does not matter which diagonal the start/end points define, Dcam 
will do its best to make sense of it.  

 

• If you do not enter a valid Profile name in the "Finished Part Profile", 
then the cycle generated will be a simple TURN or FACE cycle within 
the limits you specify.  
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• If you enter valid Profile names for both the "Finished Part Profile", 
and the "Raw Material", then Dcam will assume that the "Raw 
material" profile represents a casting / forging and will assume that 
everything outside of it is fresh air. In the examples folder see the job 
‘Machined form casting’.  

  

 

 

The cycle can be modified according to which options are ticked in the dialogue box. 

 

OPTION DESCRIPTION 

External The cycle will be carried out on the external diameter of the workpiece. 
i.e. the feed will be from outside towards the centre line.  

Internal The cycle will be carried out on an internal diameter of the workpiece. i.e. 
the feed will be from the centre line towards the outside.   

Turn/Face The cycle will consist of a series of 
cuts along the Z-axis with the feed 

in direction in the X-axis  

  

TURN 

The cycle will consist of a series of 
cuts along the X-axis with the feed 

in direction in the Z-axis. 

 
FACE 

Stay Out 
of 

Undercuts 

Depending upon the tool tip definition, the cutter may be able to partially 
machine re-entrant areas of the workpiece. Normally it will do this - if you 
do NOT wish it do so, tick this box  
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RAW MATERIAL PROFILE 
If the raw material (blank or billet) is 

defined by a profile, it can be entered 
here and will be used as a limit to the 
machining. This will avoid air cutting 

when a shaped casting is used. 

FINISHED PART PROFILE 
A profile name entered here will be 

used as a limiting (protected) profile to 
amend the machining as defined by the 

simple XZ co-ordinates (see above). 

The button enables you to use the cursor to pick either of the above profiles 
directly from the screen. If you click on the button, the dialog will be temporarily 
removed and the cursor will be placed in the display screen. Move the cursor over 
the required profile and click with the left hand mouse button. The dialog will re-
appear with the name of the profile entered in the appropriate field. 

LIMITING 
PROFILES 

Roll sharp corners: PartMaster can machine external sharp corners either by 
rolling the tool around the corner or by extending the tool path to the intersection 
point. It defaults to rolling around external sharp corners 

             

FINISH & 
CUTDEPTH

The Finish fields allow you to define a different finishing 
allowance for both the Z and X axes. This is the amount of 
material that will be left on the part profile for finishing operations.  
The Cutdepth specifies the in-feed between successive passes 
of the cutter. If no depth is entered here then the program will 
default to the cutdepth value specified in the tooling Definition. 
See Tooling - Tool Definition  
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Machining - Partoff 
 

The button on the Operations Toolbar is a shortcut for this command 

This command enables you to define a partoff cycle to separate the finished part from the 
billet.   

 

 

  

  

CYCLE 
LIMITS 

These fields enable you to define two corners to define the 
position at which the partoff will take place. Note that for the 
second corner, only an X-axis value is required as a partoff cycle 
only takes place at one Z-position.  

The button enables you to use the cursor to pick a position 
on the screen directly without having to know the exact co-
ordinates. If you click on the button, the dialog will be temporarily 
removed and the cursor will be placed in the display screen. Move 
the cursor to the required position and click with the left hand 
mouse button. The dialog will re-appear with the co-ordinates of 
the indicated position entered in the appropriate fields. If you hold 
down the Shift key when you click on the screen position, the 

cursor will change to a and PartMaster will pick up the exact 
co-ordinates of the nearest geometry point, either of the blank or 
the part profile. 

           The cycle can be modified according to which options are ticked in the dialogue box. 
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OPTION DESCRIPTION 

Pause Pause: This enables you to program a pause in seconds 
when the tool reaches the greatest depth of the cycle. 

Use Part 
Catcher 

If a part catcher is used to catch the part that has been parted 
off, then click this tick box to send an appropriate command to 
the post processor. The Part Catcher can also be 
programmed separately See Part Catcher  

          
 
 
 
 

MISCALLANEOUS FUNCTIONS 
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Barfeed 
 

The button on the Miscellaneous Operations Toolbar is a shortcut for this 
command 

This option allows you to send a command to the post processor to move activate an 
automatic (powered) barstock feeder. Options allow you to specify the advance feed distance 
of the feeder as well as options to stop and start the spindle before operating the feeder and 
to pause the feeder for a given number of seconds. Which of these options are required will 
depend upon the implementation of the bar feed device for the lathe in question. 

 
 
 
 

Block Skip 
 

The button on the Miscellaneous Operations Toolbar is a shortcut for this 
command 
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With this command you can specify an segment of the program which will be enclosed within 
"optional" markers. These commands will only be carried out if the NC machine is set to read 
the optional blocks 

 

Chuck 
 

The button on the Miscellaneous Operations Toolbar is a shortcut for this 
command 

This option allows you to send a command to the post processor to either open or close an 
automatic (powered) chuck   

 

 

Coolant 
 

The button on the Miscellaneous Operations Toolbar is a shortcut for this 
command 

This option allows you to switch the flood coolant flow on the machine on or off as well as a 
enabling you to control through the tool coolant for machines that are fitted with this option. 
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Feedrate 

The button on the Miscellaneous Operations Toolbar is a shortcut for this 
command 

This option allows you to reset the cutting feedrate at any time during the program. 

 

Insert 
 

This command can also be accessed via the button  on the Miscellaneous 
Operations Toolbar 

 
With this command you can specify a remark or other text which will be inserted into the NC 
code. See also post-processing. 

PP Function 
 

This command can also be accessed via the PP Function button on the 
Miscellaneous Operations Toolbar 
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With this command you can address a function that has been built into the post processor. 
The function is called by number and a parameter can also be passed. It is generally used to 
active special commands and features that are not available within the normal PartMaster 
machining commands 

Tailstock 
 

The button on the Miscellaneous Operations Toolbar is a shortcut for this 
command 

This option allows you to send a command to the post processor to move an automatic 
(powered) tailstock to its forward or rearwards position. The Z-axis co-ordinate of the forward 
position can be input into the field provided.  

 
           If a tailstock drawing is defined, this can be accessed and will be used in the graphic 
simulation on screen.  
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Stop 
 

The button on the Miscellaneous Operations Toolbar is a shortcut for this 
command 

This option allows you to switch the NC machine off, either with a direct or optional stop 
command. Additional options allow you to switch both the spindle and coolant off as well, if 
necessary. See also Coolant  and Spindle 

 

 

Spindle 
 

The button on the Miscellaneous Operations Toolbar is a shortcut for this 
command 

This option allows you to stop and start the spindle at any time as well as allowing you to 
enter a new spindle speed. 
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Part Catcher 
 

The button on the Miscellaneous Operations Toolbar is a shortcut for this 
command 

This option allows you to open or close a part catcher which is normally used in conjunction 
with a Partoff operation. See Machining - Partoff 

 

 

 
 

Help Menu 
 

 
This menu contains commands to open this help file and to show information about the 
version number of DCAM.  

Help Topics: This field of the help menu accesses this help file. 

What’s New: Opens a file which gives information about the latest release of the software.  

Tip of the Day: Opens a dialog which gives helpful tips about Partmaster CAM 
About DCAD: Opens a Dialog with three tabs which show information about DCAD - Version 

No. Serial No. etc. This function can also be accessed via the button on the top toolbar 

Dolphin on the Web: Will open the Internet Explorer and access the Dolphin Web Site. To 
be successful you must have a valid Internet connection. 
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Language: Opens a dialog in which you can select the required language from the pull-down 
list. At the moment English is the only valid choice.  

Activate License ... This command gives you access to the Wizard which will take you 
through the process of activating your users license. To do this you will need to acquire an 
activation code from Dolphin. All Dolphin products may be downloaded from the Dolphin 
website and will be complete in every detail except that the final output functions will be 
restricted. To turn your software into a full working product you need only obtain the activation 
code from Dolphin and then follow this procedure.  

Change License ... This command gives you access to the wizard which will take you 
through the steps necessary to change or update your license. An update code will be 
required which you can obtain from Dolphin 

  

Help - About DCAM 
 

This command displays a dialog which contains information about the version number and 
other information about Dcam. 

 

 

  

Help - What's New 
 

Opens a help file which documents all the various alterations and fixes of the various software 
releases 
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View Menu 
 

 
This menu contains commands to do with displaying the geometry and toolpath on screen as 
well as enabling you to set default values for a wide range of options..  

 

View - Cycle Time Data 
 

This command opens the a dialog where data concerning machining times for the currently 
defined machining cycles is displayed. 

 

View - Editor Font 
 

This command enables you to select the font that will be used to display the NC code 
generated by the post processor. This text is displayed in the Edit NC Code area of the 
screen. The standard Windows Font dialog will be opened which will display all the fonts 
currently installed on your computer - select the required font, style, size and colour. 
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View - Geometry Info 
 

This command opens the a dialog where a list of all the currently defined geometry is 
displayed. 

 
Geometry can be activated or deactivated by means of the click boxes provided. If it is 
deactivated it will not be displayed on screen. 

A geometric element can be deleted by clicking on it to highlight it and then hitting the Delete 
button. 

You can edit the parameters of a geometric element by double clicking on it with the left hand 
mouse button. A new dialog displaying the parameters is displayed: 

 

  

View - NC Program 
 

This command opens a window beneath the normal graphic window where the current NC 
program (after post processing) is displayed This window will also be opened automatically if 
you run a post process operation on the current program. 
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View - Notes 
 

The View - Notes command opens a window in which you can add any notes that you wish to 
the program. When you have finished the note, hit the ESC key or the close icon on the 
window. You will be asked it you wish to save the note. If an existing note has been saved 
you can re-open it with the View - Notes command. The note can be edited or you can add 
further information as required. The View Note window is "sticky" i.e. it will remain displayed 
at all times irrespective of any other operations that you perform until   you close it. The View-
Notes command may also be used to provide on-line help in carrying out various operations. 
Some preliminary versions of these tutorials may be found in the How Do I ... folder. If the 
Notes dialog is visible when the program document is closed, it will automatically be re-
displayed when that program is next opened. The dialog may be resized (by dragging its 
edges with the mouse) and can be moved around the screen by dragging its title bar. 
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View - Options 
 

The button on the Top Toolbar is a shortcut for this command, or right click when 
the cursor is in the graphics area. 

This command opens the Display Options Dialog where you can set a wide range of options 
for displaying both the geometry and toolpath’s and cutting sequences. 

 
A general description is given below but the details will vary depending upon whether 
the Milling or Turning module is being used.  

Tool Drawing 

The toolpath and machining that you define can be displayed in three different ways as 
follows: 

1 
The toolpath is shown as a centre line only. The button on the main 
toolbar is a shortcut for this option 

2 
The toolpath is shown as a centre line with an animated cutter. The
 button on the main toolbar is a shortcut for this option.  

3 A full simulation of the cutter path with an animated cutter and shading 
of the machined part. Note that full tool geometry can only be shown if 

the tool geometry is defined within a tool database. The button on 
the main toolbar is a shortcut for this option 

Geometry 

Geometry display options are available as follows:  

1 The geometry can be shown at the work surface only or with depth (if 
defined) 
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2 The names of geometric entities can be displayed 

3 The span numbers of elements within geometric entities can be 
displayed 

4 The direction of spans within geometric entities can be displayed 

The geometry that you have defined or imported can be displayed in any one of four view 
directions as follows: 

1 Isometric. The  button on the main toolbar is a shortcut for this 
option. 

2 Plan view (XY). The button on the main toolbar is a shortcut for this 
option 

3 Front View (XZ). The button on the main toolbar is a shortcut for 
this option 

4 Side View (YZ). The button on the main toolbar is a shortcut for 
this option 

 

View - Preferences 
 

This command opens the User Preferences Dialog where you can set a default values for a 
wide range of options. 
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View - Preferences - Angles 
 

This command opens the User Preferences Dialog where you can set a default values for a 
wide range of options. 

 

 

View - Preferences - Colours 
 

This command opens the User Preferences Dialog where you can set a default values for a 
wide range of options. 
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View - Preferences - Distance 
 

This command opens the User Preferences Dialog where you can set a default values for a 
wide range of options. 

 

View - Preferences - Feed Per Min 
 

This command opens the User Preferences Dialog where you can set a default values for a 
wide range of options. 
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View - Preferences - Feed Per Revolution 
 

This command opens the User Preferences Dialog where you can set a default values for a 
wide range of options. 

 

  

View - Preferences - Folders 
 

This command opens the User Preferences Dialog where you can set a default values for a 
wide range of options. 
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View - Preferences - Fonts 
 

This command opens the User Preferences Dialog where you can set a default values for a 
wide range of options. 

 

View - Preferences - Options 
 

This command opens the User Preferences Dialog where you can set a default values for a 
wide range of options. 
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View - Preferences - Retract 
 

This command opens the User Preferences Dialog where you can set a default values for a 
wide range of options. 

 

 

View - Preferences - Simulation 
 

This command opens the User Preferences Dialog where you can set a default values for a 
wide range of options. 
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View - Preferences - Spindle 
 

This command opens the User Preferences Dialog where you can set a default values for a 
wide range of options. 

 

View - Preferences - Tabs 
 

This command opens the User Preferences Dialog where you can set a default values for a 
wide range of options. 
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View - Preferences - Tuning 
 

This command opens the User Preferences Dialog where you can set a default values for a 
wide range of options. 
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View - Preferences - User Name 
 

This command opens the User Preferences Dialog where you can set a default values for a 
wide range of options. 

 

View - Preferences - Z Planes 
 

This command opens the User Preferences Dialog where you can set a default values for a 
wide range of options. 
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View - Redraw 
 

The button on the Top Toolbar is a shortcut for this command 

The View - Redraw command redraws the current graphic screen, removing any toolpath’s 
that are displayed. Note that the toolpath’s are NOT deleted, they are simply removed from 
the visual display. 

 

View - Rulers 
 

The View - Rulers command displays both horizontal and vertical rulers along the top & left 
hand side of the display screen id a single plan view is selected. The origin of the scales is 
placed at the program origin point. Movement of the cursor is shown by dynamic movement of 
cross hairs on the scales. 

 

                                                                     The screen Rulers 

 

 

 

 86



View - Split 
 

This command splits the screen into four smaller windows containing the four views which are 
normally available. The active screen is chosen by clicking within one of the four windows 
with the left hand mouse button. Program execution and simulation is only shown within the 
currently selected window. 

 

  

    This is the SPLIT VIEW icon  

View - Toolbars 
 

This command opens the View - Toolbars sub-menu which you can use to switch the display 
of all the screen toolbars on or off. 
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View - Zoom 
 

 
This sub-menu contains commands to zoom the screen display: 

View - Zoom - Cursor 
 

The button on the Top Toolbar is a shortcut for this command 

The geometry displayed on screen is redrawn so that the area defined by the cursor just fits 
inside the screen limits. Any toolpath’s that are displayed will be removed from the screen. 
Note that the toolpath’s are NOT deleted, they are simply removed from the visual display. 

Click on the icon and then move the cursor into the graphic display area. move to one corner 
of the area that you wish to display. Click and hold down the left hand mouse button. Drag the 
cursor to the diagonally opposite corner of the desired area. A rubber band box will be drawn 
to shown the area defined. When the box is at the desired position release the mouse cursor. 
The area of the screen defined by the box will be redrawn so that it just fits within the display 
area. 

View - Zoom - Cutter Path 
 

The screen is redrawn so that the cutter path is just fitted within the screen extents.. 

View - Zoom - Double 
 

The button on the Top Toolbar is a shortcut for this command 

The geometry displayed on screen is doubled in size. Any toolpath’s that are displayed will be 
removed from the screen. Note that the toolpath’s are NOT deleted, they are simply removed 
from the visual display. 

View - Zoom - Extent 
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The button on the Top Toolbar is a shortcut for this command 

The geometry displayed on screen is redrawn so that all the defined elements just fit inside 
the screen limits. Any toolpath’s that are displayed will be removed from the screen. Note that 
the toolpath’s are NOT deleted, they are simply removed from the visual display. 

 

View - Zoom - Half 
 

The button on the Top Toolbar is a shortcut for this command 

The geometry displayed on screen is halved in size. Any toolpath’s that are displayed will be 
removed from the screen. Note that the toolpath’s are NOT deleted, they are simply removed 
from the visual display. 

View - Zoom - Previous 
 

The screen is redrawn to the last selected zoom option. 

View - Zoom - Selection 
 

The screen is redrawn so that the currently selected geometry (contour etc.) is just fitted 
within the screen extents.. 

  

Window Menu 
 

 
This menu contains commands which control how the various programs that you have loaded 
will be displayed.  

All the programs that you have currently loaded are listed at the bottom of the menu. Click on 
any one of these names with the left hand mouse button to select it as the currently active 
program. 
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